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Overview
Model Maker is a MarketPlace solution that provides a simple and powerful user experience 

for modeling.

Model Maker is an extension of the OneStream Platform that allows you to perform edge 

modeling efficiently and in a streamlined way. Bend and flex a model quickly, but also have 

the governance needed to connect that information to the corporate model.

You can create a complete model from the main screen:

 l Create public or private models starting from a corporate standard.

 l Create members and hierarchies specific to each model.

 l Create reports and data entry forms.

 l Create data driven formulas, with no scripting.

 l Import data from a .csv file directly into the model.

 l Integrate the model with the corporate solution.

 l Review multiple reports from the same screen and export them in multiple formats.
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Setup and Installation
This section contains important details related to the planning, configuring, and installation of 

your solution. Before you install the solution, familiarize yourself with these details.

Dependencies

Component Description

OneStream

6.8.0 or later

Minimum OneStream Platform version required to install this version 

of Model Maker.

OneStream App 

for Windows

Model Maker is optimized for the OneStream application for Windows, 

which provides the same functionality as the browser-based version 

of OneStream.

Select the Model Maker Development 
Location 
Before beginning installation, decide whether to build the solution directly in the Production 

OneStream application or in a separate Development OneStream application. This section 

provides some key considerations for each option.

Production OneStream Application: The primary advantage of building the solution in a 

Production application is that you will not have to migrate the resulting work from a 

Development application. However, there are intrinsic risks when making design changes to 

an application used in a Production capacity and not advised.
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NOTE: OneStream strongly recommends that you implement the solution in the 

Development environment with a fresh copy of the Production application before 

starting work.

Development OneStream Application: As a best practice, use the Development OneStream 

application to build the solution.

Create the OneStream Development 
Application

 1. Ensure that all the OneStream artifacts relating to Model Maker, such as entities, are in 

the Production application. A workflow profile will also be required to import the data 

back into your corporate model.

 2. Copy your Production OneStream application to your Development environment and 

rename it. Use this Development version for your Model Maker project. 

Application Server Settings
Edit the OneStream Application Server Configuration so users can create and change data in 

the additional database tables. If other MarketPlace solutions (such as Specialty Planning) 

are in the application, these adjustments may already exist.

Configure the OneStream Application Server
Be sure that the security group settings include the users set up and use the Model Maker 

before proceeding.
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NOTE: Group settings are applicable to all MarketPlace solutions, so keep group 

names generic.

 1. Start the OneStream Server Configuration Utility as an administrator.

 2. Click Open Application Server Configuration File > Database.

 3. Edit the following OneStream Database Server properties:

 l Access Group for Ancillary Tables: Select a group that includes those who will 

access records.

 l Can Create Ancillary Tables: True

 l Can Edit Ancillary Table Data: True

 l Maintenance Group for Ancillary Tables: Select a group who will edit and 

maintain tables.

 l Table Creation Group for Ancillary Tables: Select a group who can create 

tables.
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 4. Restart the Internet Information Server.

Install Model Maker
 1. On the OneStream MarketPlace, click MarketPlace > Model Maker.

 2. On the Model Maker solution page, select the appropriate OneStream platform version 

from the Minimum Platform Version drop-down list. 

 3. Select the most recent version from the Solution Version drop-down list and then click 

Download.

 4. Log in to OneStream.

 5. On the Application tab, click Tools > Load/Extract. 
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 6. On the Load tab, locate the solution package using the Select File icons and click 

Open.

 7. When the solution’s file name appears, click Load. 

 8. Click Close to complete the installation. 

Set Up Model Maker
The first time you run Model Maker, a guided table setup process begins.

In OneStream, click OnePlace > Dashboards > Model Maker > Model Maker.

Create Tables
 1. Click Step 1: Create Tables.

This step may be necessary when upgrading even if tables are already present. Model 

Maker will not remove any tables that already exist but will modify table structures and 

add any new ones if necessary.

 2. When setup is complete, click Step 2: Launch Solution to open Model Maker.
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Package Contents
The Dashboard Maintenance unit provides the user interface for Model Maker and includes 

the required dashboard groups, components, data adapters, parameters and files.

Data Management
The data management sequences and steps shown in the following image are created to be 

used with their related business rules. The benefit of running these processes through a data 

management sequence is that they can run in the background while you continue your work.

Security
After installation, administrators see a drop-down list in the Global Options tab on the Settings 

page called Security Role [Access Model Maker]. It is set to the Administrators security 

group by default. 

Non-administrators, upon installation, will not see Model Maker in the OnePlace tab.

At any point, if the Access Model Maker security group is changed or updated, the 

administrator will see a validation message stating that the Access Group on all Dashboard 

Maintenance Units and Dashboard Profile for the Model Maker Solution was also updated.

Administrators can remove and restore any model. Non-administrators can only remove 

models that they created.  Non-administrators cannot restore models that have been removed.

NOTE: Removing a model will also remove the viewing permissions of that model 

based on security levels other than Private.
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Global Options
Use the Global Options settings to set security roles and the scenario type in which every 

model in Model Maker will use.

NOTE: Global Options are only available to administrators.

If you chose to keep the Access Model Maker Security Role and the Scenario Type defaults, 

you must click Save to register the defaults as your chosen selections.

Access Global Options
 1. Click Settings.

 2. Make sure that Global Options is selected.

Security Settings
After installation, the  Access Model Maker setting is set to the Administrators security group 

by default.
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Create a Security Group
We recommend that the OneStream administrator  creates a security group called Model 

Maker and assigns the administrator in the group and any other group that will use Model 

Maker for their edge modeling process.

At any time, if additional groups need access to Model Maker, the administrator can update 

children of the Model Maker security group.  This action will streamline solution security.

Scenario Type
The Scenario Type is set to  Model by default.

Model Maker Dashboard
Administrators can see the Settings page and the Help page. They can see Create, Remove, 

and Restore (with a drop-down list to choose which model to restore).

For non-administrator users, only the Help page displays. They can only see the Create and 

Remove icons for model cube definitions.  If non-administrators need a model cube definition 

restored, they must contact an administrator for support.

You will notice that the icon for your active page displays a different color to indicate which 

page you currently have selected.

For example:
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Active Page Inactive Page

Uninstall
The Uninstall feature allows you to uninstall the user interface or all solutions in Model Maker. 

If performed as part of an upgrade, any modifications that were made to standard solution 

objects are removed.

IMPORTANT: The Uninstall option uninstalls all solutions integrated in Model Maker.

The uninstall options are:

 1. Uninstall UI removes all solutions integrated into Model Maker, including related 

dashboards and business rules but leaves the databases and related tables.

IMPORTANT: This procedure resets the Workspace Dashboard Name to 

(Unassigned). An administrator must manually reassign the Workspace Dashboard 

Name after performing an Uninstall UI.

 2. Uninstall Full removes all the related data tables, data, dashboards, and business 

rules from all solutions integrated into Model Maker. Select this option to completely 

remove the solutions or to perform an upgrade that is so significant in its changes to the 

data tables that this method is required.

CAUTION: Uninstall procedures are irreversible.
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IMPORTANT: The standard Uninstall Full process has been modified to also include 

deletion of any metadata created in or specific to the Model Maker Solution.
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Models
Model Maker offers two options for creating new models: extend a base cube or create a new 

cube. If you extend a base cube, it inherits all of the dimensions from the base cube. 

For every model you create, there is a dedicated cube view group. This makes it easier for 

security setting, publishing, sharing and model deletion. Each new cube view group is 

automatically added to the Model Maker Cube Views Profile.

You can create, extend or remove a model. The Last Action column shows the status of model 

cube definitions that has a model cube created for it.  If a model cube has not been created, the 

Last Action column will remain blank.  Last Action types include: 

 l Created: Displays when you create a model cube definition.

 l Copied: Displays when you create a model cube definition  from an extension of an 

existing model.

 l Removed: Displays when you remove a model cube.

 l Restored: Displays when an administrator restores a removed model cube. Only 

administrators can restore a model cube.

Each cube view group follows this naming convention: 

mlm_[ Model Cube Name ]_Dimension suffix

NOTE: If you leave the Base Cube Name field empty, OneStream creates a new 

cube with new dimensions at the root level.
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Model Security
The Security column indicates if the model is Private, Public, or limited to a specific group. 

 l Private: You created the model and only you can see it. Private is the default setting.

 l Public: Everyone in the Access Group established in Global Options can see the model.

 l Other Groups:  Specific groups in the Access Group as established in Global Options.

You can assign different security levels on each of your models.

When you navigate to other sub-solutions in Model Maker, such as Formulas or Views, you 

will only see the Public models and your Private models listed in the model cubes drop-down 

list. This is the same case for each sub-solution that contains a model cube drop-down list.

If a security group outside of Public or Private is assigned to the model, you will only have 

permission to view models assigned to that group if you are in that group. For example, if Club 

Controllers is assigned to the Security of a given model cube, you would only see it if you are a 

user in Club Controllers.

NOTE: If you are not an administrator, you cannot change security on a model that 

you did not create.

For more detailed information about Model Maker security, see "Appendix A Security" on 

page 84.
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Create a Model
You can edit the Description and Security columns from the Model Page dashboard after you 

create a model. However, after you create the model, you cannot edit the Model Cube Name, 

Base Cube Name, Dimension Suffix, Scenario Type, Last Action, Time Stamp or User Name 

columns.

No Cube Selected displays above (and to the left) of the Model Cube Definitions table. This is 

replaced by the model cube name when you create and select a model cube.  If you did not 

create the model cube  from the model cube definition, No Cube Selected will remain.  This 

indicates model cube definitions that have yet to be created.

Model cube definitions must be unique. If you try saving a new model cube definition with the 

same model cube name and dimension suffix for any Last Action state, you receive a 

validation message.

 1. Click Launch Model Cube Creator Page.

 2. On the Models dashboard, click Insert Row and enter the following information:

 a. Model Cube Name: Name of the model 

 b. Base Cube Name: Name of the base cube. Required if you are copying a base 

cube. To extend from an existing corporate model, see "Extend a Model" on 

page 16.

 c. Dimension Suffix: Required to segregate dimensions created for the new model.

 d. Description: Detailed description for the model
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 e. Scenario Type: Defaults to the Global Settings scenario type after saving the 

model cube definition.

 f. Security: Defaults to Private. The list in the Security column reflects the group 

children assigned under the Model Maker security group.

 3. Click Save.

NOTE: When you save a model cube definition, the description is the only 

editable field.

 4. Click Create.

 5. Add provided dimensions from Platform. Because the model was created from root,  

establish your members and create hierarchies for the dimensions provided.

Because you created a new cube, all dimensions are created at the root level except for 

Entity and Scenario.  This cube is separate from the rest of the application and you can 

add members to new dimensions. 

NOTE: The Entity and Scenario dimension are named mlm_EntityDim_

Dimension Suffix and mlm_ScenarioDim_Dimension Suffix, respectively.
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Extend a Model
Extending a model allows you to apply extensible dimensionality.  The dimension hierarchies  

in the extended model are inherited in Model Maker so you can modify members specifically 

for your edge model case. When extending from a corporate model, Model Maker will inherit 

the corporate design at that point in time.

NOTE: By default, IC Entity is set to False. If you extend a model where the original 

entity dimension member is set to True, the newly created entity dimension member 

for IC Entity is False. 

 1. On the Models dashboard, click Insert Row and enter the following information:

 a. Model Cube Name: Name of the model 

 b. Base Cube Name: Name of the base cube based on the cube you would like to 

extend.

 c. Dimension Suffix: Required to segregate dimensions created for the new model.

 d. Description: Detailed description for the model

 e. Scenario Type: Defaults to the Global Settings scenario type.

 f. Security: Defaults to Private. The list in the Security column reflects the group 

children assigned under the Model Maker security group.

 2. Click Save and then click Create.
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 3. Select the Base Scenario and click Continue. A dialog box displays that the cube was 

created. The dimensions of the base cube name are now inherited. 

See "Members" on page 21 for more information.

Remove a Model
When you remove a model cube, all items related to that model are archived and then deleted. 

These include the following items, removed in this specific order:
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 1. Data

 2. Parameter sets

 3. Cube views

 4. Integrations, for example transformation rules, data sources, and connectors

 5. Data management jobs

 6. Metadata

 7. Dimensions and members in the cube

NOTE: If you remove a model by mistake, you can contact your administrator to 

restore model cube assets.  However, data is not restored.

The removed models display in  the Model page dashboard but the Last Update column will 

state Removed. If you would like the administrator to restore the model at any time, the model 

name is available in the list.  

NOTE: If you do not want to see the removed models in the list, you can reorder the 

Last Action column through the column filter.

 1. Select a model cube from the list.

 2. Click Remove.
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 3. Click Continue. The Last Action column updates to Removed.

A data management job runs to remove all artifacts.

IMPORTANT: If you highlight a Removed model cube, click on the "-" icon and save 

it. The model cube is permanently deleted and the model cannot be restored.

Restore a Model
NOTE: Only users with administrator privileges can restore models. 

Click Restore. The model appears in the list and the Last Action column updates from 

Removed to Restore.
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Administrators can restore removed model cube definitions from a drop-down list of removed 

cubes from the Model page.

NOTE: You cannot create a model based on a model that has been removed.
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Members
The Members page allows you to create new metadata either for a model created from root or 

from an extended model. It inherits the corporate structure while allowing downward extension 

to achieve a higher granularity. It also allows for departmental use cases not implemented in 

corporate models. You can extend every dimension freely, as long as you choose member 

names that are not already in use for that dimension type.

Import and Manage Members 
Use the Members page to create or configure metadata and dimensions, or the members you 

will use in your application. 

There are many ways to enter new dimensions and members.  You can manually add them or 

add extended members under existing members.   Both ways are valid and will create the 

metadata needed for your model.

 1. Click Launch Member Manager Page.

 2. In Model Cube, select the new cube you created or an existing cube.

NOTE: If you selected a model on the Models page, that model will be 

selected.

 3. In Dimension, choose a dimension type to extend.
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 4. Make sure that Auto Update is selected.

This ensures the spreadsheet automatically refreshes. If it is unchecked, you will need 

to select the Refresh icon  to refresh the spreadsheet. Auto Update is enabled by default.

 5. Scroll through the Parent hierarchy to see the structure inherited from the application.
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 6. Use the spreadsheet on the right to edit members. When you highlight a member  in the 

hierarchy, the spreadsheet will refresh with the information last saved for that member.  

Save minor edits of the member attributes  in the spreadsheet component.

 7. In the example above, AdsRevenues and SubRevenue were added to the inherited 

member of account 60000 - Operating Sales. 

The spreadsheet updates with the hierarchy in the Parent field. 

 8. When you select an item in the Parent hierarchy the spreadsheet view to the right 

updates.  

NOTE: Blue rows in the spreadsheet are for new members.

Action Icons in Member Hierarchy
You can only make modifications to the hierarchy  on members that were created in Model 

Maker. You cannot modify members in gray because they are inherited.
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Icon Description

Delete the member.

Delete the member and its children.

Rename the member.

Copy the member.

Paste a selected member.

Move the member to the parent level.

Move the member down.

Move the member  up.

Sort the member children up.

Sort the member children down.

Member Hierarchy Options            
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Upload Data from a Text File
The Load, Type or Drop Here box is ideal for bulk loads. To make minor changes to bulk 

metadata, use the spreadsheet to add a member and assign the Account Type if applicable, 

then click Save.

Use Load, Type or Drop Here  to populate the hierarchy in multiple ways. You can load 

members  via text or .csv file, freehand, or use the spreadsheet columns to establish parent 

and children to copy and paste into this text box.

To load from a text or .csv file, select Upload text file below the text box to retrieve the file 

and click  Create New Hierarchy.  When loading an external file, use a space, comma, or 

semi-colon to separate member name and descriptions. Use double quotes  to include spaces 

in the name or description.

Click the Information icon for more information on using the Upload text box.
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Upload your account information using a semi-colon and indented syntax format into the 

Load, Type or Drop Here box.

 1. Click Upload text file.

 2. Browse to the text file and click Open.

 3. The account syntax from the text file populates the box.
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 4. Click Create New Hierarchy to create the group, the accounts and any hierarchies.
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Copy and Paste from Excel
 1. If you have a hierarchy of members in Excel, copy the cells.

 2. Paste the cells in the Load, Type or Drop Here box.

 3. Click Create New Hierarchy to add  the members you pasted from Excel into the 

dimension hierarchy.
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The new content from Excel also displays in the spreadsheet.

 4. After you add content from Excel, select a dimension in the Parent hierarchy to make 

changes in the spreadsheet.
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 5. Change the Account Type, Is Average, or Weight.

Weight can be: 

 l 1: Aggregate all the data to the parent.

 l 0: Data does not aggregate; it is false.

 l -1: Change the data aggregation to negative values. For example,  change the 

account type to expense for a negative value.

The Aggregation setting is available in all Account, Flow and UD dimensions.  This 

setting can change for a Base Entity based on its parent.  If a member is reused in 

a dimension, but it does not need to sum up more than once, set the weight to 0 

data in this node and it will not allow the member to aggregate to the top.

 6. Click Save.

Add Information Directly to the Spreadsheet
If you are making minor changes you can also use the spreadsheet to  add a member and 

assign the Account Type if applicable, then click Save.
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 1. Copy a few cells from Excel to extend the account.

 2. Highlight the account in the Member hierarchy. The spreadsheet display updates to 

show this account.

 3. Paste the cells directly into the spreadsheet view.
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 4. Select the Account Type and click Save. The Parent hierarchy dynamically updates to 

reflect what you changed in the spreadsheet.
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Views
Create views for the data in the model for input and reporting. 

Select rows, columns, and point of view for what you would like to see in the report. After you 

build the report,  return the results as a web form, spreadsheet, or a PDF. Save the view as 

either private or public. 

You can use views that you have already created as a basis for formulas, data input and 

reporting.

NOTE: The rows and columns dimension defaults to children and not base.

Design the Cube View
The Views page allows you to design what your cube view will look like. You can save filter 

values that dictate how your cube view is rendered. Your cube view is not created until you 

click Create Cube View.

After you create your cube view on the user interface you are looking at the visual 

interpretation of the data at the time the cube view was created. You will see the actual cube 

view  on  the Formulas or Review pages.

You can create a cube view for:

 l Formula editing on the Formulas page

 l General use such as data import and collaboration
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After you create a model, cube views that you create in a model are stored in that model's 

cube group. 

NOTE: The Access and Maintenance group in the cube view group inherits the 

security group assigned in  Global Settings Access and Maintenance Group settings 

upon creation.

Open the Views Page
 1. Click Launch Cube View Builder Page.

 2. Select a cube.

NOTE: If you selected a cube on the Model page, these filters are pre-selected: 

Scenario, Entity, Account, UD1-8, and the cube section of the Select Member 

dialog box.

 3. Select specific cube view properties, point of view, and style. 

NOTE: Style applies to Cube View and Spreadsheet.

 4. (Optional) For each dimension, choose a point of view member.
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Area in Header Toolbar Description

Rows and Columns filters 

provide the design flexibility 

needed to determine the 

granularity of your dimensions 

in a cube view.

1 - Use the first 3 icons (Open 

Saved Filter Values, Save 

Filter Values, and Delete 

Saved Filter Values) to  design 

and modify your filter 

definition. 

2 - Use the fourth icon (Create 

Cube View) to create the 

actual  cube view.

 

Options to keep or remove 

specific members 

Each query has its own keep 

or remove member filters.

Cube View Properties
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Area in Header Toolbar Description

Point of View: All dimensions 
that are neither in row nor 
column and are instead the 
Point of View of the cube view.

 

 

Input Allocation: Allocate 

equal values to children 

members of a parent. Apply 

the total value on the parent 

and the children will get the 

shared value of that total. 

NOTE: Input Allocation 

is only displayed  if you 

select Read Write from 

the Cube View 

dropdown list. 

Cube View Properties

Select Rows and Columns 
 1. In Rows click an option.

Model Maker Guide 36

Views



NOTE: If the cube view uses the Account dimension in Row or Column, the 

drop-down list for the Formulas page will include that cube view and you will be 

able to write formulas into the accounts chosen.

 2. Click a Row or Column name and the Select Member dialog box opens. The filters for 

each dimension display in a hierarchy.

 3. Select or search for a member.
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 4. Click OK.

 5. To multi-select members to keep for rows and columns:

 a. Click Keep Row Members or Keep Col Members.

 

The Keep Members dialog box opens.
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 b. Select  the members to keep and click Continue.

The cube view updates to show the members you selected.
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 6. To multi-select members to remove for rows and columns:

 a. Click Remove Row Members or Remove Col Members. 

The Remove Members dialog box opens.
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 b. Select all of the members to remove and click Continue.

 c. The cube view updates to show the members you selected no longer appear in 

the view.
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Select a Template
In Rows and Columns choose Template. Templates allow you to select another cube view 

that you have in the application and it will share the rows from that cube view.

Administrators may use templates to provide pre-defined row sets and column sets.

 1. In Rows, click Template.

 2. Select a specific template to apply.
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Preview a Cube View in Spreadsheet or Report
While designing your cube view, you can visualize what it will look like prior to creating it using 

the spreadsheet or report viewer. For more information on using spreadsheets or reports, see 

Design and Reference.

Click Spreadsheet.
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Click Report.
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Save Filter Values
 1. Click Save Filter Values. 

 2. In the Save Filter Values dialog box, enter a name and description for this dynamic cube 

view. For other modelers to see it, select Public. It is Private by default.
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 3. Click Continue. Your filter value is saved.

Delete Filter Values
 1. Click Delete Saved Filter Values. The Delete Filter Values dialog box opens.

 2. Choose the filter value from the list and click Continue. The filter is deleted.

Open Filter Values
When you click Open Saved Filter Values, it is a   dynamic cube view.  This cube view is not a 

real cube view but rather set to display column and row data based on selected member filters 

only. 
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 1. Click Open Saved Filter Values. 

The Open Filter Values dialog box opens.

 2. Choose a filter value from the list and click Continue.  OneStream sets all the variables 

and shows data.
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 3. (Optional) In cube view change Read Only to Read Write if you want to change any of 

the data.

At this point  it is not saved as a cube view. 

Opening a previously saved filter view has its advantages. If there are a few modifications you 

would like to make for a new cube view, you can use a previously saved filter value as a 

baseline for those minor adjustments, save those filter values using a new filter value name, 

and create that modified cube view from your modified parameter set.

NOTE: If you save a filter value using a previously used name, your filter values will 

be overridden by the newest value set.  However, this action will not override a 

materialized cube view for the original saved filter value.  Filter values are not actual 

cube views, they are a saved set of parameter filters.

Create the Cube View
Create a cube view for  formulas.
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NOTE: How you set up the cube view and which settings you choose (Formula 

Filter, Parameter Filter, or POV Bar) dictate how you will be able to use it in 

formulas.

 1. Click Create Cube View. 

 2. Enter a name and description.

 3. Select settings for the cube view member filters. The dimensions you chose for the row 

and column will automatically default to POV Bar and all the other dimensions will be set 

to Formula Filter.
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NOTE: If you plan to apply formulas to the cube view, set all dimensions to 

Formula Filter.

 a. Formula Filter: Sets the cube view member filters to the exact member in the 

combo boxes. 
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NOTE: If you choose Formula Filter and you use the cube view to create 

a formula, the initial formula scope will match the filters in the cube view. 

However, it is possible to expand the formula scope directly in the formula 

editor. The cube view will act simply as a template to start from when 

creating the formula, while the resulting formula can span a larger 

dataset than what was included in the cube view. 

 b. Parameter Filter: Sets the selected dimensions to run-time parameters. You are  

prompted to select a member after opening the cube view.  

 c. POV Bar: Uses the correct POV pane selections. 

 4. Click Continue. A dialog box opens to state that you successfully created the cube 

view.

 5. Click OK.
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Formulas
The Formulas page provides the ability to manipulate amounts of data using a data-driven 

interface.  Formula writing allows for the selection of cells from a single cube view or multiple 

cube views to be referenced in the actual calculation. Model Maker allows you to preview, 

save or delete formulas based on your specific needs.  When a cube view is selected for 

formula writing, you can add or remove an account to the selected cube view.

Add Formulas to the Model
Your cube view setup and settings dictate how you will be able to use the cube view in 

formulas. 

Your cube view appears in your Cube View 1 drop-down list if:

 l The cube view contains the account dimension in either the row or column.

 l Upon materialization of the cube view, all dimensions were set to formula filter.

When using two cube views for formula writing, the right panel only lists cube views created in 

Model Maker.  Cube View 1 is set to cube views created in the specific model cube selected. 

 l NOTE: If you create a cube view outside Model Maker, the cube view will not 

appear in the Cube View 2 list on the Formula page. 

 l NOTE: You cannot add formulas to inherited members in your OneStream 
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application.

 l NOTE: You cannot write formulas against a parent member.

Open the Formulas Page
 1. Click Launch Account Formula Builder Page to open the  Formulas dashboard. By 

default, in Model Cube the model you chose previously is selected.

 2. In Cube View 1 select a cube view. 

Prior to creating formulas, if you have created cube views that should contain driver 

information,  you can add that data through the formulas page. 

Enter data into the white cells that indicate valid intersections of the cube view and click Save.  

The example below shows the number of customers that are FreeUsers and PremiumUsers.
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Additional drivers that help calculate the AdsRevenue is the AdsDrivers. The example below 

shows the populated data for average advertisement views, click through rates, view value 

and click value.
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You have established your data drivers. The next section will create the AdsRevenue formulas 

using the Revenue cube view. See "Create a Formula" below.

Create a Formula
 1. Select any cell within your cube view where your formula will be required. 

 2. Click the button next to Edit Formula. Notice that in the example below Edit Formula 

updates to the column selected, AdsRevenues.

 3. A formula editor opens below the formulas dropdown list that allows you to see the 

formula filters  and edit the formula if needed. 

The formula to the left of the = sign will populate initially based on the first cell defaulted 

on the cube view. If you select a different cell and click Edit Formula again, the formula 

will update to the left of the = sign to reflect the selected cell.

If you change the dimension filter, the formula will update based on your new criteria.

Model Maker Guide 55

Formulas



When the formula editor opens, a few items will default for each dimension.  These dimension 

filters are calculation filters representing all the dimensions on which the formula will run 

without any relevant change. These represent the scope for this formula.

 4. Click any dimension icon to open a Member Builder dialog box. In this example, the 

modeler clicked U4#.

 5. Click Select Member. The Select Member dialog box opens.
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 6. Choose a member from within the UD4 dimension type and click OK.

In this example the formula updated to consider FreeUsers from the dimension filter and 

is not directly noted to the left of the = sign.  Also, the modeler modified T# to reflect 

2022.Base instead of 2022M1.  The cube view is fixed, so you would not see the updates 

in the cube view itself. However, it is part of the formula.  To see the results,  create a 

variation of the cube view to analyze the full year as opposed to focusing on 2022M1.
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 7. To incorporate data drivers from another cube view, see "Open a Second Cube View" 

below.

Open a Second Cube View
 1. To incorporate data drivers from another cube view, click 2 Cube Views located on the 

right side of the cube view. A list for Cube View 2 displays all cube views that have been 

created in Model Maker.

 2. Select your desired cube with driver information, highlight the cell that contains the data 

you need, and click Update Formula.
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NOTE: Toggling between the 2 Cube View and 1 Cube View icons will change the 

user interface to show either 1 or 2 cube views.

 3. Enter *, +, /, or – and add more cells to complete the formula.

 4. As you add more cells to the formula, you will see that the account formula changes 

based on the relationship between the dimensionality of cube view 1 and cube view 2.

 5. Continue to add data into the formula from as many cube views as you need.  The image 

below shows that the modeler added a second half of the formula using the F2_

AdsDrivers rates for FreeUsers.
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 6. Model Maker will read the dependencies within your formula script and identify the 

formula pass within the highlighted area below. Since there are no dependencies in this 

example, Pass: FormulaPass1 is shown. 

 7. When your formula is complete, you can preview the results prior to saving. Refer to 

"Preview the Formula" below.

Preview the Formula
The preview allows you to see the data that the formula will return, based on your specific 

dimension filters, without running a calculation.
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 1. Click Preview Formula. The Results Preview opens. 

It contains a data table as shown below. In this example,  time is calculated for all 

months instead of 2022M1 and UD4 shows results for FreeUsers only.

 2. After the formula is established, save the formula, and calculate to see results in the 

cube view.

 a. Click Save Formula.

 b. In the Save Formula dialog box, enter a name and click Continue.
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 c. Click Calculate.

The formula is calculated.

Add Multiple Formulas to One Account
Model Maker provides the flexibility of saving multiple formulas to one account.
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 1. Select the POV cell. 

 2. In Formulas, select New.

 3. Add components to the formula and click Update Formula. 

 4. Click Save Formula.

Delete a Saved Formula
Delete formulas that are no longer relevant.

 1. Navigate to the cell that contains the formula from your cube view.

 2. Select the saved formula from the Formula drop-down list.  

 3. Click Delete and refresh your cube view.

NOTE: Once a formula is deleted, the data will remain based on the last calculation.

Save the Formula
 1. Click Save Formula.

 2. Enter a formula name and click Continue.
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Close the Formula Editor
Click Close Formula Editor.

Delete the Formula
Click Delete Formula.

Add an Account
Add an account to an existing cube view and assign the account type from the Add Account 

dialog box.  The addition or removal of an account can only be performed on the left cube view, 

Cube View 1. In the following example, we  inherit the account type that  is a child member of 

Operating Sales.
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 1. Click Add Account. The Add Account dialog box opens.

 2. Enter the following information:

 l Account Name

 l Account Description

 3. Select an Account Type and click Continue.

The new account appears in the list.

You can add formulas to the new account and save it.  Going forward, the new account is 

included in your account dimension.
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Delete an Account
 1. Select an account from the list.

 2. Click Remove Account.

NOTE: If there is data in the account, a message will ask if you want to delete 

the account.
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Data Import
Model Maker has streamlined the data loading process for modelers.  You can import large 

amounts of data via the Data Import page using a .csv file. Once the .csv file is in the correct 

format,  you can upload the file  to the OneStream File Explorer using the Import icon. 

Dimension members that default to None include: all UDs, IC, and Flow. Consolidation will 

default to Local. The only required columns needed for your .csv file import are Entity, 

Scenario, Account, and Time. 

The OneStream application also has a Validate button that checks each line of data to ensure 

data quality.

Import Data
 1. Click Launch Data Import Page. If you selected a model cube, the Model Cube field 

will be pre-populated.  If not, select the model into which you want to import data into 

from the drop-down list.

 2. Click Import and select the external .csv file that contains the information  to load. Once 

imported, you will receive confirmation that the file is in the OneStream File Explorer.

 3. Once the file is imported, select it from the File drop-down list and begin mapping your 

columns to the dimensions to the left.

NOTE: If you have already used the file, the dimension mapping will populate 

for you.
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 4. Once the mapping is defined , click Validate.

NOTE: Validate ensures that all members in the file are part of your model 

cube and saves the fields and dimension mapping of the file.  If you have 

members on the .csv file that are not part of your model, you will receive a 

message and the data will not load for those specific members.
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 5. When validation is complete, click  Load. When load is complete, you will get 

confirmation on the number of records that have successfully imported to your model.

NOTE: Load only displays after you click Validate and the validation was 

successful. You must validate before loading.

 6. Repeat the previous steps to load more files. 

If a dimension is not mapped to any column, OneStream will use the default of None for 

all UDs, IC, and Flow dimensions.  If Consolidation is not mapped, it will use the default 

of Local.  If forms is not mapped, it will use the default of Origin. 

 7. To verify, review the data and the results of your calculations. See "Review" on page 79.
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Data Export
Leverage extensibility to automatically integrate the newly created model to the corporate 

standard model. 

Select the portion of data to synchronize and choose one of the following options:

 l Preview: Allows you to preview your export prior to generating transformation rules or 

any other data source.

 l Save Connect: Create a connector or mapping of your model.

 l Save Link: Link it directly to the corporate model by generating a data management job.

 l Export to File: Export the result to a .csv file for use by other systems.
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NOTE: Performing any of the above actions will not directly impact your corporate 

model immediately.  If you choose to use Save Connect or Save Link to export your 

edge case, additional steps external to Model Maker are necessary to incorporate 

into your corporate plan and can only be done by those who have the appropriate 

security permissions. Export to File will allow you to share your edge case without 

impacting your corporate model. 

Export Data
 1. Click Launch Data Export Page. If you selected a model cube, the model cube field is 

pre-populated.  If not, select the model from which you want to export data. This will be 

the source of all the information you want exported into your corporate application.

 2. Select a cube from the drop-down list, which  contains all the models available in your 

OneStream application. Select the cube in which you want to add model information.

 3. Click Select Target Scenario. The target scenario is in the target cube you selected. 

The Select Member dialog box opens.

Model Maker Guide 71

Data Export



 4. Select your scenario and click OK.

Select Dimension Filters
All dimensions that could be included in a model are provided in Filters on the Data Export 

page. Here you have the flexibility of adding text freehand or using a Member Builder dialog 

box to identify filters applicable to your edge model.

 1. Select dimension filters by clicking the ellipses. The Member Builder dialog box opens to 

guide you to select the filter for each dimension. 

There is a relationship identifier for each dimension when comparing the Model Maker 

model to your selected target cube. See "Dimension Filters" on page 77  for more 

information.
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NOTE: If a dimension is not being used in your model, the default is None. 

 2. Click Select Member. 
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 3. Navigate  the hierarchy or use the Search to select an entity dimension and click OK. 

The Member Builder dialog box populates with your selection.

 4. The filter populates with your selection.
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 5. Repeat the previous steps to assign other dimensions. The example below shows the 

dimensions populated specific to this use case.
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 6. Click Preview to view the data as it will be exported.

 7. OneStream pre-aggregates the data using extensibility and provides a data set, which is 

already mapped correctly to the cube.
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Dimension 
Filter

Description

Entity Specific to your target cube to which you are adding model information. 

Select a base entity.

All other filters identify the dimension information from the source 

model, so the filters you choose will vary based on how your use case 

was built and the data that was applied to your model.

Shared Indicates that the dimension is shared and a mask type transformation rule 
automatically generates once the export is complete. A pass-through rule 
may be generated and a star for the rule expression and target value is  
assigned depending on the dimension. This ensures data passes from the 
source model to the target cube for that dimension. 

Scenario Always unrelated and the mapping is treated as a one-to-one relationship. 

Unrelated Indicates that the information for this dimension is exported as a source 
and you must map manually.  The information from the source model is not 
aggregated and the granularity of the information will remain. 

New Indicates that the dimension in the source model is not used in the target 
cube. The data in the new dimension used in Model Maker  forces the 
information to aggregate in None in the target cube since that is the only 
valid area of OneStream to place data for that dimension. 

Extended Data will aggregate according to the hierarchical structure of the extended 
dimension. 

Dimension Filters

Save a Connector
Use the dimension settings you configured as a connector for your cube.

Click Save Connect.
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OneStream creates the following:

 l A connector rule

 l A data source with all of the dimensions

 l Transformation rules for mapping

Everything you need to add the model to a workflow import process is created.

NOTE: The Connector Rule, Data Source and Transformation Rule naming 

conventions are prefixed with MME_ .

When performing a data export on a model cube, any additional exports done on the same 

model cube will override transformation rules and connectors from the original export. 

Essentially each model cube exported will have one connector rule, one data source and one 

transformation rule for that group of data.
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Review
Analyze the model with reports you created by choosing different screen layouts or combining 

private and public reports in a single report page.

The Review page of Model Maker provides a dashboard area to review models with others. 

You can view two models in a horizontal or vertical format.

Review Model Data
 1. Click Launch Cube View Review Page.

 2. Select a model cube if one is not selected. If you already selected a model cube, the 

model cube field is pre-populated.

 3. In Cube Views Layout, select one of the following:

 l 1 Cube View

 l 2 Cube Views (Vertical)

 l 2 Cube Views (Horizontal)

 4. Select 1 Cube View.

 5. In Cube View 1, select a cube view. The cube views in this drop-down list are specific to 

your selected model cube.
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 6. (Optional) If you chose 2 Cube Views, select Cube View 2. The Cube View 2 drop-down 

lists all cube views created in Model Maker.
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Help and Miscellaneous 
Information

This page contains solution documentation.

Display Settings
OneStream and MarketPlace solutions frequently require the display of multiple data 

elements for proper data entry and analysis. Therefore, the recommended screen resolution is 

a minimum of 1920 x 1080 for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text 

setting to 100% and do not apply any Custom Scaling options.

Package Contents and Naming Conventions
The package file name contains multiple identifiers that correspond with the Platform. 

Renaming any of the elements contained in a package is discouraged to preserve the integrity 

of the naming conventions.

Example Package Name: MLM_PV6.8.0_SV100_PackageContents.zip

Identifier Description

MLM Solution ID

PV6.8.0 Minimum Platform version required to run solution
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Identifier Description

SV100 Solution version

PackageContents File name

Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution with 

custom tables such as this one. The relationship between OneStream objects such as 

workflow profiles and custom solution tables is that they point to the underlying identifier 

numbers and not the object names as seen in the user interface. Prior to the solution 

configuration and to ensure the identifiers match within the development and production 

applications, the development application should be a recent copy of the production 

application. Once the development application is created, install the solution and begin 

design. The following process below will help migrate the solution tables properly.

See also: Managing a OneStream Environment in the Design and Reference Guide.
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MarketPlace Solution Modification 
Considerations
A few cautions and considerations regarding modification of MarketPlace solutions:

 l Major changes to business rules or custom tables within a MarketPlace solution will not 

be supported through normal channels as the resulting solution is significantly different 

from the core solution.

 l If changes are made to any dashboard object or business rule, consider renaming it or 

copying it to a new object first. This is important because if there is an upgrade to the 

MarketPlace solution in the future and the customer applies the upgrade, this will 

overlay and wipe out the changes. This also applies when updating any of the standard 

reports and dashboards.

 l If modifications are made to a MarketPlace solution, upgrading to later versions will be 

more complex depending on the degree of customization. Simple changes such as 

changing a logo or colors on a dashboard do not impact upgrades significantly. Making 

changes to the custom database tables and business rules, which should be avoided, 

will make an upgrade even more complicated.
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Appendix A Security
Solution Security
Below is a matrix that represents the high-level solution security upon install of the Model 

Maker solution. We strongly encourage administrators to create a security group called Model 

Maker as mentioned in "Global Options" on page 8. The Model Security section represents 

what a user is able to modify upon security level access on the model in a more granular level.
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High level

NOTE: The Model Maker security group is comprised of child groups containing 

administrators and non-administrators (power users).
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Model Security

Public: Open to the Security group and its child groups assigned in Global Settings.

Private: Only the administrator or modeler who created the model cube can  modify it.

Other group: A modeler can only view or copy a cube that is available to them.
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